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1 Foreword
The SY6 safety module adds the Safe Torque Off (STO) and Safe Stop 1 (SS1) safety functions, both described as standard in
EN 61800-5-2, to drive controllers of the SC6 and SI6 series.

STO prevents an electrical rotating magnetic field, needed for the operation of synchronous or asynchronous motors, from
being generated in a drive controller immediately once the safety function has been activated. In the case of SS1-t, the
switch-off happens after a configurable amount of time.

For a combination consisting of a drive controller and SY6 safety module, the STO and SS1 safety functions are actuated via
EtherCAT (FSoE).

SY6 is a fast and wear-free fully electronic solution. The safety module is designed so that regular system tests that
interrupt operation are eliminated. In practical terms, this means increased availability of machines and systems. The often
complex planning and documentation of function tests are also eliminated.

Drive controllers with an integrated safety module can be used in systems with high safety requirements up to SIL 3, PL e,
category 4. Compliance with standard requirements has been certified by an independent testing institute as part of type-
examination.

Drive controllers of the SC6 and SI6 series successfully passed the EtherCAT as well as Fail Safe over EtherCAT (FSoE)
Conformance Test. There, the communication interface was tested to ensure the reliability and function of the lower-level
communication regardless of vendor.
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2 User information
This documentation provides all information on the intended use of the drive controller in combination with the SY6 safety
module.

2.1 Storage and transfer
As this documentation contains important information for handling the product safely and efficiently, it must be stored in
the immediate vicinity of the product until product disposal and be accessible to qualified personnel at all times.

Also pass on this documentation if the product is transferred or sold to a third party.

2.2 Described product
This documentation is binding for:

Drive controllers of the SC6 or SI6 series in combination with the SY6 safety module and DriveControlSuite (DS6) software in
V 6.6-B or later and associated firmware in V 6.6-B-EC or later.

2.3 Standards
The following standards are relevant to the product specified in this documentation:

§ EN ISO 13849-1:2015

§ EN ISO 13849-2:2012

§ EN 61800-5-2:2017

§ EN 61508-x:2010

§ EN 60204-1:2018

§ EN 62061:2005 + Cor.:2010 + A1:2013 + A2:2015

§ IEC 61784-3:2010

Subsequent references to the standards do not specify the respective year in order to improve readability.

2.4 EU declaration of conformity
We, STÖBER Antriebstechnik GmbH + Co. KG, declare that the products described in this document correspond the
requirements of the guidelines of the European Parliament and of the Council.

Complete product-specific EU declaration of conformity can be found at http://www.stoeber.de/en/downloads/ or you can
obtain it from our service department.

2.5 Timeliness
Check whether this document is the latest version of the documentation. We make the latest document versions for our
products available for download on our website:
http://www.stoeber.de/en/downloads/.

2.6 Original language
The original language of this documentation is German; all other language versions are derived from the original language.

http://www.stoeber.de/en/downloads/
http://www.stoeber.de/en/downloads/
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2.7 Limitation of liability
This documentation was created taking into account the applicable standards and regulations as well as the current state of
technology.

No warranty or liability claims for damage shall result from failure to comply with the documentation or from use that
deviates from the intended use of the product. This is especially true for damage caused by individual technical
modifications to the product or the project configuration and operation of the product by unqualified personnel.

2.8 Formatting conventions
Orientation guides in the form of signal words, symbols and special text markups are used to emphasize specific
information so that you are able identify it in this documentation quickly.

2.8.1 Display of warning messages and information
Warning messages are identified with symbols. They indicate special risks when handling the product and are accompanied
by relevant signal words that express the extent of the risk. Furthermore, useful tips and recommendations for efficient,
error-free operation are specially highlighted.

ATTENTION!

Attention

This indicates that damage to property may occur

▪ if the stated precautionary measures are not taken.

CAUTION!

Caution

This word with a warning triangle indicates that minor personal injury may occur

▪ if the stated precautionary measures are not taken.

WARNING!

Warning

This word with a warning triangle means there may be a considerable risk of fatal injury

▪ if the stated precautionary measures are not taken.

DANGER!

Danger

This word with a warning triangle indicates that there is a considerable risk of fatal injury

▪ if the stated precautionary measures are not taken.

Information

Information indicates important information about the product or serves to emphasize a section in the documentation that
deserves special attention from the reader.
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2.8.2 Markup of text elements
Certain elements of the continuous text are distinguished as follows.

Important information Words or expressions with a special meaning

Interpolated position mode Optional: File or product name or other name

Detailed information Internal cross-reference

http://www.samplelink.com External cross-reference

Software and other displays

The following formatting is used to identify the various information content of elements referenced by the software
interface or a drive controller display, as well as any user entries.

Main menu 
Settings

Window names, dialog box names, page names or buttons, combined
proper nouns, functions referenced by the interface

Select 
Referencing method A

Predefined entry

Save your 
<own IP address>

User-defined entry

EVENT 52: 
COMMUNICATION

Displays (status, messages, warnings, faults)

Keyboard shortcuts and command sequences or paths are represented as follows.

[Ctrl], [Ctrl] + [S] Key, key combination

Table > Insert table Navigation to menus/submenus (path specification)

2.8.3 Mathematics and formulas
The following signs are used to represent mathematical relationships and formulas.

– Subtraction

+ Addition

× Multiplication

÷ Division

| | Absolute value

http://www.stoeber.de
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2.9 Trademarks
The following names used in connection with the device, its optional equipment and its accessories are trademarks or
registered trademarks of other companies:

EtherCAT®,
Safety over EtherCAT®

EtherCAT® and TwinCAT® are registered trademarks and patented technologies,
licensed by Beckhoff Automation GmbH, Germany.

TwinCAT® TwinCAT® is a registered and licensed trademark of Beckhoff Automation GmbH,
Germany.

All other trademarks not listed here are the property of their respective owners.

Products that are registered as trademarks are not specially indicated in this documentation. Existing property rights
(patents, trademarks, protection of utility models) are to be observed.

2.10 Explanation of terms
As relevant standards and products of other manufacturers are referenced, different manufacturer- or standard-specific
names are used for the same term in this documentation.

For improved understandability, the names in this documentation are standardized to the terminology of STOBER to the
greatest extent possible. The correlation of STOBER names to other sources can be found in the following table.

STOBER EtherCAT FSoE

Controller EtherCAT MainDevice FSoE MainInstance

Drive controller EtherCAT SubDevice FSoE SubInstance

Tab. 1: Correlation of STOBER terminology to EtherCAT and FSoE
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3 Safety notes

WARNING!

Risk of fatal injury if safety notes and residual risks are not observed!

Failure to observe the safety notes and residual risks in the drive controller documentation may result in accidents causing
serious injury or death.

▪ Observe the safety notes in the drive controller documentation.

▪ Consider the residual risks in the risk assessment for the machine or system.

WARNING!

Malfunction of the machine due to incorrect or modified parameterization!

In the event of incorrect or modified parameterization, malfunctions can occur on machines or systems which can lead to
serious injuries or death.

▪ Observe the security notes in the drive controller documentation.

▪ Protect the parameterization, e.g. from unauthorized access.

▪ Take appropriate measures for possible malfunctions (e.g. emergency off or emergency stop).

3.1 Qualified personnel
In order to be able to perform the tasks described in this documentation, the persons instructed to perform them must
have the appropriate professional qualification and be able to assess the risks and residual hazards when handling the
products. For this reason, all work on the products as well as their operation and disposal may be performed only by
professionally qualified personnel.

Qualified personnel are persons who have acquired the authorization to perform these activities either through training to
become a specialist and/or instruction by specialists.

Furthermore, valid regulations, legal requirements, applicable basic rules, this documentation and the safety notes included
in it must be carefully read, understood and observed.

3.2 Intended use
The SY6 safety module can be combined with STOBER drive controllers of the SC6 or SI6 series.

If a drive controller with the integrated SY6 safety module is used in a safety-related application, the safety module must be
activated by a safety relay or a safety controller.

DANGER!

Electrical voltage! Risk of fatal injury due to electric shock!

An active STO safety function only means that generation of the rotating magnetic field at the motor has been interrupted.
The motor may still be energized with dangerous high voltages.

▪ Make sure that persons cannot come into contact with conductive parts.

▪ If the supply voltage must be switched off, observe the requirements of EN 60204-1.
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Improper use

The safety module may not be operated outside of the drive controller or operated not in compliance with the applicable
technical specifications.

Information

An emergency off in accordance with EN 60204-1 is not possible with the SY6 safety module! 
Observe this standard regarding the difference between emergency off and emergency stop in conjunction with Safe
Torque Off.

Modification

As the user, you may not make any technical or electrical modifications to the SY6 safety module. Any removal of the
module from the drive controller as well as any attempt at repair or replacement is prohibited.

Maintenance

The safety module does not require maintenance.

3.3 Decommissioning
In safety-oriented applications, note the mission time TM = 20 years in the safety-relevant key performance indicators. A
drive controller with integrated safety module must be taken out of operation 20 years after the production date. The
production date of the drive controller is found on the accompanying nameplate.
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4 Safety module SY6
The SY6 safety module adds the STO (Safe Torque Off) and SS1 (Safe Stop 1) safety functions to the drive controller. The
module prevents the formation of a rotating magnetic field in the power unit of the drive controller and, in the event of an
error or by external request, switches the drive controller to the STO state immediately or after a time delay (SS1-t).

Features

§ Possible safety functions:

• Safe Torque Off – STO in accordance with EN 61800-5-2

• Stop category 0 in accordance with EN 60204-1

• Safe Stop 1 (time-delayed) – SS1-t in accordance with EN 61800-5-2

• Stop category 1 in accordance with EN 60204-1

§ Activation of the safety functions using Safety over EtherCAT (FSoE)

§ STO switch-off time: < 50 ms

§ Wear-free

Certifications in accordance with EN 61800-5-2 and EN ISO 13849-1

§ Safety Integrity Level  (SIL) 3

§ Performance Level  (PL) e

§ Category 4
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5 System design and function
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Fig. 1: Components of the FSoE-based safety concept

System components

Central components of the FSoE-based safety concept are:

§ Drive controller with integrated SY6 safety module
... for implementing the STO and SS1-t safety functions

§ Controller (PLC) with integrated EtherCAT MainDevice
... for organizing all network communication

§ Bus coupler (EtherCAT coupler)
... as a connector between the controller and safety controller; the bus coupler passes frames from the safety
controller to the EtherCAT MainDevice

§ Safety controller (S-PLC) with integrated FSoE MainInstance
... for FSoE communication and logic gate links between FSoE nodes; the safety controller includes certified safety
function modules that can be configured to the specific application using suitable automation software

§ Safe connections with fail-safe digital inputs and outputs
... for the connection of 24 VDC safety sensors such as emergency stop or position switches, light barriers, pressure mats
etc.

§ FSoE protocol
... for the transmission of safety-related data

§ EtherCAT
... as the underlying fieldbus system
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Function

The control unit of the drive controller generates pulse patterns (PWM) to produce a rotating magnetic field at the IGBT
module in the power unit. This rotating magnetic field is necessary for operating synchronous and asynchronous motors.

If the STO safety function is not active, the SY6 safety module allows for the generation of a rotating magnetic field in the
power unit. The connected motor can create a rotating magnetic field. If the safety function is active, the safety module
disables the generation of the rotating magnetic field in the power unit and the drive controller cannot generate any torque
in the connected motor.

The SY6 safety module represents an FSoE SubInstance. It exchanges control and status information with the FSoE
MainInstance via the EtherCAT MainDevice in accordance with the black channel principle. The SubInstance extracts the
safety-related data, checks it for plausibility and enables or disables the two safety channels in the power unit.

The STO and SS1-t safety functions relate to the device and are not axis-specific. On double-axis controllers, both axes are
brought to a safe state at the same time. An activated SS1-t cannot be interrupted.

DANGER!

Risk of fatal injury due to gravity-loaded vertical axes or motor coasting!

The drive controller in the motor cannot generate torque when the STO safety function is active. Consequently, vertical
axes subject to gravitational forces may fall. If the motor is moving when STO is activated, it will coast uncontrolled.

▪ Secure gravity-loaded vertical axes by braking or taking similar actions.

▪ Make sure that the motor coasting does not create any hazards.

WARNING!

Increased overrun distance! Residual motion!

The safety module cannot prevent a failure of the functional part of the drive controller (e.g. during a controlled stop) while
the SS1-t safety function is executed. Therefore, SS1-t cannot be used if this failure could cause a dangerous situation in the
end application. Observe this during project configuration.

In the event of an error in the power unit of the drive controller, static energization of the motor is possible despite active
STO. In this case, the motor shaft can move by an angle of up to 360° ÷ (p × 2).
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6 Technical data
The transport, storage and operating conditions of the safety module correspond to those of the drive controller. The
technical data is part of the drive controller manual (see Detailed information [} 61]).

The following table contains the key figures relevant to safety technology for the SY6 safety module.

SIL CL 3

SIL 3

PL e

Category 4

PFHD 5 × 10-9 [1/h]

Mission time (TM) 20 years

STO switch-off time < 50 ms

SS1 delay time 10 – 655350 ms (± 1%)

Tab. 2: SY6 – Key safety-related figures
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7 What you should know before commissioning
The following chapters provide a quick introduction to the structure of the program interface and accompanying window
designations as well as relevant information about parameters and generally saving your project configuration.

7.1 Program interfaces
The following chapters include an overview of the program interfaces for the described software components.

7.1.1 DS6 program interface
Using the graphical interface of the DriveControlSuite commissioning software (DS6), you can project, parameterize and
commission your drive project quickly and efficiently. In case of service, you can evaluate diagnostic information such as
operating states, fault memories and fault counters of your drive project using DriveControlSuite.

Information

The program interface of DriveControlSuite is available in German, English and French. To change the language of the
program interface, select Settings > Language.

Information

The DriveControlSuite help in the menu bar can be reached via Help > Help for DS6 or via the [F1] key on your keyboard.
When you press [F1] in an area of the program, the corresponding help topic opens.

1 2

3

4

5

6 7 8
9

Fig. 2: DS6: Program interface
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No. Area Description

1 Menu bar Using the File, View, Settings and Window menus, you can open and save projects, display
and hide program windows, select the interface language and access level and change
between different windows in the workspace.

2 Toolbar The toolbar enables quick access to frequently needed functions, like opening and saving
projects and hiding and displaying windows in the program interface.

3 Project tree The project tree forms the structure of your drive project in the form of modules and drive
controllers. Select an element using the project tree first in order to edit it using the
project menu.

4 Project menu The project menu offers you various functions for editing the project, module and drive
controller. The project menu adapts to the element that you selected in the project tree.

5 Workspace The different windows which can be used to edit your drive project, such as the
configuration dialog, wizards, the parameter list or the scope analysis tool, open in the
workspace.

6 Parameter check The parameter check points out irregularities and inconsistencies that were detected in
the plausibility check of calculable parameters.

7 Messages The entries in the messages log the connection and communication status of the drive
controllers, incorrect inputs caught by the system, errors when opening a project or rule
violations in the graphical programming.

8 Variable parameter
lists

You can use variable parameter lists to compile any parameters in individual parameter
lists for a quick overview.

9 Status bar In the status bar, you can find the specifications of the software version and get additional
information about the project file, the devices and the progress of the process during
processes such as loading projects.

7.1.1.1 Configuring the view

In DriveControlSuite, you can change the visibility and arrangement of areas and windows, such as to optimize the available
space in the workspace when working with smaller screens.

Showing/hiding areas

Use the icons in the toolbar or the items in the View menu to show or hide specific areas in DriveControlSuite as needed.

Icon Item Description

– Reset Resets the view to factory settings.

Project Shows/hides the Project window (project tree, project
menu).

Messages Shows/hides the Messages window.

Parameter check Shows/hides the Parameter check window.

Variable parameter lists Shows/hides the Variable parameter lists window.

Arrange and group areas

You can undock and rearrange the individual areas via drag and drop. If you drag an undocked window to the edge of
DriveControlSuite, you can release it there in a color-highlighted area either next to or on top of another window to redock
it.

When you release the window onto another window, the two areas are merged into one window where you can use tabs to
switch between the areas.
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7.1.1.2 Navigation using sensitive circuit diagrams

Fig. 3: DriveControlSuite: Navigation using text links and symbols

In order to illustrate graphically the processing sequence of actual and set values, the use of signals or certain drive
component arrangements and to make configuring the accompanying parameters easier, they are displayed on the
respective wizard pages of the workspace in the form of circuit diagrams.

Blue text links or clickable icons indicate links within the program. These refer to the corresponding wizard pages and, as a
result, allow you to reach additional helpful detail pages with just a click.
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7.1.2 TwinCAT 3 program interface
In TwinCAT 3, you operate your EtherCAT system using TwinCAT XAE. The following graphic shows the interface elements
relevant to this documentation.

3

4

58

21

6

7

Fig. 4: TwinCAT 3 (TwinCAT XAE): Program interface

No. Area Description

1 Menu bar The menu bar shows the menus set by default. Editor-specific menus appear only when the
corresponding editor is open. Using the Tools menu, you can configure the user interface
and add to existing menus or define new ones, for example.

2 Toolbar The toolbar enables quick access to frequently used functions, such as opening and saving
projects.

3 Solution explorer The solution explorer maps the structure of your project with the project elements it
contains. First select an element using the solution explorer to edit it in the main window.

4 Main window (editor) In the main window, you define and edit objects, e.g. graphical programming elements.

5 Message window The message window informs you of any errors or warnings currently present. You also
receive messages about the syntax check, compilation process, etc.

6 Properties window The properties window shows the properties of the element selected in the solution
explorer.

7 Toolbox Displays the "tools" available for the active editor, such as graphical programming
elements.

8 Information and status
bar

The information and status bar informs you about the state of the system (Config, Run,
Stop or Exception mode). In online operation, you can see the current status of the
program. If an editor window is active, the current position of the cursor and the set
editing mode are also displayed.
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7.2 Meaning of parameters
You can use parameters to adapt the function of the drive controller to your individual application. In addition, parameters
visualize the current actual values (actual velocity, actual torque, etc.) and trigger actions such as Save values, Test phase,
etc.

Interpretation of parameter identification

Parameter identification consists of the following elements, where short forms are also possible, i.e. only specifying a
coordinate or the combination of coordinate and name.

E50 V0

Coordinate Name Version

Drive controller G6

Drive controller
generation/series

7.2.1 Parameter groups
Parameters are assigned to individual groups by topic. The drive controllers differentiate between the following parameter
groups.

Group Topic

 A Drive controllers, communication, cycle times

B Motor

C Machine, velocity, torque/force, comparators

D Set value

E Display

F Terminals, analog and digital inputs and outputs, brake

G Technology – Part 1 (application-dependent)

H Encoder

I Motion (all motion settings)

J Motion blocks

K Control panel

L Technology – Part 2 (application-dependent)

M Profiles (application-dependent)

N Additional functions (application-dependent; e.g. extended cam control unit)

P Customer-specific parameters (programming)

Q Customer-specific parameters, instance-dependent (programming)

R Production data for the drive controller, motor, brakes, motor adapter, gear unit and geared motor

S Safety (safety technology)

T Scope

U Protection functions

Z Fault counter

Tab. 3: Parameter groups
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7.2.2 Parameter types and data types
In addition to topic-based sorting in individual groups, all parameters belong to a certain data type and parameter type. The
data type of a parameter is displayed in the parameter list, properties table. The connections between parameter types,
data types and their value range can be found in the following table.

Data type Parameter type Length Value range (decimal)

INT8 Integer or selection 1 byte (signed) -128 – 127

INT16 Integer 2 bytes (1 word, signed) -32768 – 32767

INT32 Integer or position 4 bytes (1 double word,
signed)

-2 147 483 648 –
2 147 483 647

BOOL Binary number 1 bit (internal: 
LSB in 1 byte)

0, 1

BYTE Binary number 1 byte (unsigned) 0 – 255

WORD Binary number 2 bytes (1 word, unsigned) 0 – 65535

DWORD Binary number or parameter
address

4 bytes (1 double word,
unsigned)

0 – 4 294 967 295

REAL32
(single type according to
IEE754)

Floating-point number 4 bytes (1 double word,
signed)

-3.40282 × 1038 – 3.40282 ×
1038

STR8 Text 8 characters —

STR16 Text 16 characters —

STR80 Text 80 characters —

Tab. 4: Parameters: Data types, parameter types, possible values

Parameter types: Use

§ Integer, floating-point number
For general computing processes
Example: Set and actual values

§ Selection
Numeric value to which a direct meaning is assigned
Example: Sources for signals or set values

§ Binary number
Bit-oriented parameter information that is collected in binary
Example: Control and status words

§ Position
Integer combined with associated units and decimal places
Example: Actual and set values of positions

§ Velocity, acceleration, deceleration, jerk
Floating-point number combined with associated units
Example: Actual and set values for velocity, acceleration, deceleration, jerk

§ Parameter address
Referencing of a parameter
Example: In F40 AO1 source, for example, E08 n-motor filtered can be parameterized

§ Text
Outputs or messages
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7.2.3 Parameter types
The following types of parameters are differentiated.

Parameter type Description Example

Simple parameters Consist of one group and one line with a
defined value.

A21 Brake resistor R: Value = 100 ohms

Array parameters Consist of a group, a line and multiple
sequential (listed) elements, which have the
same properties but different values.

A10 Access level

§ A10[0] access level: Value = Access level
via operating unit

§ A10[2] access level: Value = Access level
via CANopen and EtherCAT

§ A10[4] access level: Value = Access level
via PROFINET

Record parameters Consist of a group, a line and multiple
sequential (listed) elements, which can have
different properties and different values.

A00 Save values

§ A00[0] Start: Value = Start action

§ A00[1] Progress: Value = Display action
progress

§ A00[2] Result: Value = Display action
result

Tab. 5: Parameter types

7.2.4 Parameter structure
Every parameter has specific coordinates with the following structure.

E250 [2] .3

Axis
Group

Line

1.

Element
Bit

§ Axis (optional)
In case of multiple axes, the one to which a parameter is assigned; not applicable for global parameters (value range: 
1 – 4).

§ Group
The thematic group to which a parameter belongs (value range: A – Z).

§ Line
Distinguishes the parameters within a parameter group (value range: 0 – 999).

§ Element (optional)
Elements of an array or record parameter (value range: 0 – 16000).

§ Bit (optional)
Selection of a single bit for complete data addressing; depends on the data type (value range: 0 – 31).
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7.2.5 Parameter visibility
The visibility of a parameter is primarily controlled by the access level you set in DriveControlSuite and by the properties
you project for the respective drive controller (e.g. hardware, firmware and application). A parameter can also be shown or
hidden depending on other parameters or settings. For example, the parameters of an additional function are only shown
as soon as you activate the relevant additional function.

Access level

The access options for the individual software parameters are ranked hierarchically and divided into individual levels. This
means that parameters can be hidden for a specific purpose and, relatedly, their configuration options can be locked
starting from a specific level.

Each parameter has one access level for read access (visibility) and one access level for write access (editability). The
following levels are present:

§ Level 0
Elementary parameters

§ Level 1
Important parameters of an application

§ Level 2
Important parameters for service with extensive diagnostic options

§ Level 3
All parameters needed for commissioning and optimizing an application

The parameter A10 Access level controls general access to parameters:

§ Over CANopen or EtherCAT (A10[2])

§ Over PROFINET (A10[3])

Information

It is not possible to write to or read the parameter hidden in DriveControlSuite during communication via fieldbus.

Hardware

Which parameters are available to you in DriveControlSuite is determined by which series you select in the configuration
dialog for the drive controller, for example, or whether you project an option module. Basically, the only parameters that
are displayed are the ones you need to parameterize the configured hardware.

Firmware

Due to the further development and updating of functions for the drive controllers, new parameters and also new versions
of existing parameters are continuously being implemented in DriveControlSuite and in the firmware. The parameters are
displayed in the software according to the DriveControlSuite version used and the configured firmware version of the
respective drive controller.

Applications

Applications generally differ in terms of functions and their control. For this reason, different parameters are available with
each application.



7 | What you should know before commissioning STOBER

24

08
/2

02
4 

| 
ID

 4
42

74
4.

04

7.3 Signal sources and process data mapping
The transmission of control signals and set values in DriveControlSuite meets the following principles.

Signal sources

Drive controllers are controlled either over a fieldbus, using mixed operation consisting of a fieldbus system and terminals
or exclusively using terminals. 
You can use the corresponding selection parameters, referred to as signal sources, to configure whether the control signals
and set values of the application are obtained over a fieldbus or using terminals.

In case of activation over a fieldbus, parameters that are selected as data sources for control signals or set values must be
part of the subsequent process data mapping. In the case of activation using terminals, the respective analog or digital
inputs are specified directly.

Process data mapping

If you are working with a fieldbus system and have selected the source parameters for control signals and set values,
configure the fieldbus-specific settings, e.g. the assignment of the process data channels for transmitting receive and
transmit process data, as the last step. The respective procedure can be found in the accompanying fieldbus manuals.

7.4 Non-volatile memory
All project configurations, parameterizations and related changes to parameter values are in effect after transmission to the
drive controller, but are only stored in volatile memory.

Saving to a drive controller

To save the configuration in non-volatile memory on a drive controller, you have the following options:

§ Saving the configuration using the Save values wizard:
Project menu > Wizards area > Projected axis > Save values wizard: Select the Save values action

§ Saving the configuration using the parameter list:
Project menu > Parameter list area > Projected axis > Group A: Drive controller > A00 Save values: Set the parameter
A00[0] to the value 1: Active

§ Saving the configuration using the S1 operating button:
Drive controller with S1 operating button: Press and hold the operating button for 3 s

Saving to all drive controllers within a project

To save the configuration in non-volatile memory on several drive controllers, you have the following options:

§ Saving the configuration using the toolbar:
Toolbar > Save values icon: Click the Save values icon

§ Saving the configuration using the Online functions window:
Project menu > Online connection button > Online functions window: Click on Save values (A00)

Information

Do not shut off the drive controller while saving. If the supply voltage to the control unit is interrupted while saving, the
drive controller will start with fault 40: Invalid data the next time it is switched on. To successfully complete the saving
procedure, the configuration must be stored again in non-volatile memory.
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8 Commissioning
The following chapters describe the commissioning of your drive controller with an integrated SY6 safety module using
DriveControlSuite and the TwinSAFE configurator of TwinCAT 3 from Beckhoff Automation GmbH & Co. KG.

We assume the following system environment as an example so that you can follow the individual commissioning steps
exactly:

§ Drive controller of the SC6 or SI6 series in firmware version V 6.4-D-EC or later with integrated SY6 safety module

§ DriveControlSuite commissioning software in version V 6.4-D or later

in combination with

§ Beckhoff CX2030 – CPU base module (controller, EtherCAT MainDevice)

§ Beckhoff TwinSAFE EL6900 logic terminal (safety controller, FSoE MainInstance)

§ Beckhoff EK1100 bus coupler (EtherCAT bus coupler)

§ Beckhoff TwinSAFE 4-channel EL1904 digital input terminal (digital terminal with 4 failsafe inputs)

§ Beckhoff TwinCAT 3 automation software: TwinCAT System Manager (TwinSAFE configurator), TwinCAT XAE

Commissioning is divided into the following steps:

1. SY6 safety module
Enter a valid FSoE address using DIP switches.

2. Observe the time setting recommendations for the following configuration.

3. DriveControlSuite
Configure all drive controllers, including the safety module, device control, process data for fieldbus communication
and axes of your drive system, in DriveControlSuite. Generate an ESI file then transmit your project configuration to
the drive controllers of the system network.

4. TwinCAT 3
Make the generated ESI file available to TwinCAT 3. Next, map your entire hardware environment and configure it.
Then activate your system and check the TwinSAFE communication of the connected device.

8.1 SY6: Assigning the FSoE address
In order to be able to identify the SY6 safety module in the FSoE network, you must assign it a unique address in the FSoE
network. The address is based on values from the DIP switches on the top of the drive controller that are switched to ON.
For more information on this, see SY6: Assigning the FSoE address [} 57].

Information

The drive controller must be switched off before you assign the address for the SY6 safety module using the S12 DIP
switches. The drive controller has to be restarted to apply the address.
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8.2 Recommended time settings
In the event of a quick stop with a subsequent STO (stop category 1 in accordance with DIN EN 60204-1 or Safe Stop 1 
(SS1-t) in accordance with DIN EN 61800-5-2) or in the event of a controlled axis stop, the communication is interrupted
and the power unit may be deactivated prematurely. In this case, axis movement can no longer by controlled by the drive
controller.

In order to prevent premature deactivation of the power unit, you must take the delay time for the quick stop (quick stop
time) into account when parameterizing the SS1 delay time.

Quick stop time

The quick stop time is an application-specific result of the quick stop deceleration and maximum velocity. Parameterize the
quick stop deceleration in A578 Quick stop deceleration in the CiA 402 application and in I17 Quickstop deceleration in
Drive Based applications. Parameterize the maximum velocity in I10 Maximal speed.

SS1 delay time

Set a larger value for T_SS1 in the FSoE MainInstance than for the resulting quick stop time. The reserve should generally be
10% and should not fall below 50 ms. You can check the SS1 delay time in S593 SS1 time until STO.

FSoE watchdog time

Set a sufficiently large value for the watchdog time in TwinCAT 3 to prevent unintentional false triggering (e.g. due to a
cycle time that is too slow) or fault 70: Parameter consistency with cause 15.

Note the following condition:

S27 Safety watchdog time > A258 EtherCAT PDO-Timeout + S26 FSoE cycle time + 26 ms

In TwinCAT 3, a global watchdog time of 100 ms is set by default.

For more information on the watchdog time, see Watchdog time [} 58].

8.3 DS6: Configuring the drive controller
Project and configure all drive controllers for your drive system using DriveControlSuite.

8.3.1 Initiating the project
In order to be able to configure all drive controllers and axes of your drive system using DriveControlSuite, you must record
them as part of a project.
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8.3.1.1 Projecting the drive controller and axis

Create a new project and project the first drive controller along with the accompanying axis.

Information

Make sure that you project the correct series in the Drive controller tab. The projected series cannot be changed
afterwards.

Creating a new project

1. Start DriveControlSuite.

2. On the start screen, click Create new project.

ð The new project is created and the configuration dialog for the first drive controller opens.

ð The Drive controller button is active.

Projecting the drive controller

1. Properties tab: 
Establish the relationship between your circuit diagram and the drive controller to be projected in DriveControlSuite.

1.1. Reference:
Define the reference code (equipment code) of the drive controller.

1.2. Designation:
Give the drive controller a unique name.

1.3. Version:
Version your project configuration.

1.4. Description:
If necessary, save additional supporting information (e.g., the change history).

2. Drive controller tab:
Select the series, device type and firmware version of the drive controller.

2.1. Firmware:
Select the EtherCAT version 6.x -EC.

3. Option modules tab, Safety module:
Select the SY6 safety module.

4. Device control tab:
Project the basic control of the drive controller.

4.1. Device control:
Select CiA 402 device control.

4.2. Rx process data, Tx process data:
If you use a fieldbus to control the drive controller, select the corresponding receive and transmit process data.

4.3. If you are working with hardware and software products from Beckhoff and are using the SDO Info service,
select EtherCAT Rx SDO Info and EtherCAT Tx for the transmission of the EtherCAT process data. You set up the
SDO Info service in TwinCAT 3. For more information, refer to the manual for communication with EtherCAT.
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ATTENTION!

Change of addressing when changing the template

If you change the template from EtherCAT Rx to EtherCAT Rx SDO Info, the addressing of the elements of array and record
parameters also changes. Note this in particular for existing configurations. For the templates, various ESI files are created.
When changing the template, you must create a new ESI file using the wizards in DriveControlSuite and provide it to
TwinCAT 3. A template change also causes a change to the revision number of the drive controller. Therefore, restart the
drive controller after changing the template.

Projecting the axis

1. Click Axis A.

2. Properties tab: 
Establish the relationship between your circuit diagram and the axis to be projected in DriveControlSuite.

2.1. Reference:
Define the reference code (equipment code) of the axis.

2.2. Designation:
Give the axis a unique name.

2.3. Version:
Version your project configuration.

2.4. Description:
If necessary, save additional supporting information (e.g., the change history).

3. Application tab:
Select the CiA 402 application (incremental version).

4. Motor tab:
Select the type of motor you operate with this axis. If you are working with motors from third-party suppliers, enter
the accompanying motor data later.

5. Repeat the steps for axis B (only for double-axis controllers).

6. Confirm with OK.
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8.3.2 Parameterizing general EtherCAT settings

ü You have projected the SY6 safety module and the device control with the process data as part of drive controller and
axis project configuration.

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >
Wizard area.

2. Select the EtherCAT wizard.

3. A213 Fieldbus scaling:
Leave the default setting at 1: Native (values are passed unchanged).

4. A258 EtherCAT PDO-Timeout:
In order to be able to detect a communication failure, monitor the arrival of cyclical process data by defining a PDO
timeout. 
Permitted value range: 0 – 65535 ms. 
Please note:
0 and 65535 = Monitoring is inactive 
1 to 65531 = Monitoring is active
65532 = Monitoring is active but the loss of an individual data packet is ignored
65533 = Monitoring is active but the loss of 3 data packets in a row is ignored

5. Optional: If you would like to use the SDO Info service, define which objects the controller can read out via SDO Info
using A268.
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8.3.3 Configuring PDO transmission
PDO channels are able to transmit control and status information in real time as well as actual and set values from an
EtherCAT MainDevice to EtherCAT SubDevices and vice versa.

PDO communication allows for several PDO channels to be operated simultaneously per transmission and sending
direction. The channels for axes A and B each include a PDO with a defined sequence of up to 24 parameters to be
transmitted. These are free to be configured in any way. One channel is reserved for FSoE communication and is
parameterized automatically.

In order to guarantee error-free communication between the controller and drive controller, STOBER offers an application-
dependent pre-assignment of the channels which can be changed at any time.

8.3.3.1 Adapting RxPDO

ü You have configured the global EtherCAT settings.

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >
Wizard area.

2. Select the EtherCAT wizard > Received process data RxPDO.

3. Check the presets and/or configure the process data according to your requirements.
A225[0] – A225[23], A226[0] – A226[23]:
Parameters whose values are received by the respective drive controller from the controller. The position of the
parameters provides information about the associated receiving sequence.

8.3.3.2 Adapting TxPDO

ü You have configured the global EtherCAT settings.

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >
Wizard area.

2. Select the EtherCAT wizard > Transmitted process data TxPDO.

3. Check the presets and/or configure the process data according to your requirements.
A233[0] – A233[23], A234[0] – A234[23]: 
Parameters whose values the respective drive controller sends to the controller. The position of the parameters
provides information about the associated transmission sequence.
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8.3.4 Transmitting and saving the configuration
In order to transmit and save the configuration to one or more drive controllers, you must connect your PC and the drive
controllers over the network.

WARNING!

Injury to persons and material damage due to axis movement!

If there is an online connection between DriveControlSuite and the drive controller, changes to the configuration can lead
to unexpected axis movements.

▪ Only change the configuration if you have visual contact with the axis.

▪ Make sure that no people or objects are within the travel range.

▪ For access via remote maintenance, there must be a communication link between you and a person on site with eye
contact to the axis.

Information

During the search, all drive controllers within the broadcast domain are found via IPv4 limited broadcast.

Requirements for finding a drive controller in the network:

▪ Network supports IPv4 limited broadcast

▪ All drive controllers and the PC are in the same subnet (broadcast domain)

ü The drive controllers are switched on and can be found in the network.

1. In the project tree, select the module under which you have recorded your drive controller and click Online
connection in the project menu.

ð The Add connection dialog box opens. All drive controllers found via IPv4 limited broadcast are displayed.

2. Direct connection tab, IP address column: 
Activate the IP addresses in question and confirm your selection with OK.

ð The Online functions window opens. All drive controllers connected through the selected IP addresses are
displayed.

3. Select the module and the drive controller to which you would like to transfer the configuration. Change the selection
of transmission type from Read to Send.

4. Change the selection Create new drive controller:
Select the configuration that you would like to transfer to the drive controller.

5. Repeat steps 3 and 4 for all other drive controllers to which you would like to transfer your configuration.

6. Online tab:
Click Establish online connections.

ð The configurations are transferred to the drive controllers.
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Saving a configuration

ü You have successfully transferred the configuration.

1. Online functions window, Online tab, Actions for drive controller in online operation area:
Click Save values (A00).

ð The Save values (A00) window opens.

2. Select on which drive controllers you want to save the configuration.

3. Click Start action.

ð The configuration is stored on the drive controllers in non-volatile memory.

4. Close the Save values (A00) window.

Information

For the configuration to take effect on the drive controller, a restart is required: for example, after the configuration is
saved on the drive controller for the first time or when changes are made to the firmware or process data mapping.

Restarting a drive controller

ü You have stored the configuration on the drive controller in non-volatile memory.

1. Online functions window, Online tab:
Click Restart (A09).

ð The Restart (A09) window opens.

2. Select which of the connected drive controllers you want to restart.

3. Click Start action.

4. Confirm the safety note with OK.

ð The Restart (A09) window closes.

ð The fieldbus communication and connection between DriveControlSuite and drive controllers are interrupted.

ð The selected drive controllers restart.
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8.3.5 Creating an ESI file
The functions and properties of the STOBER drive controllers are described in the form of various objects and collected in
an ESI file.

Because you are working with TwinCAT 3, generating an ESI file is mandatory. The file must be made available to TwinCAT 3
in the directory specified below. Be aware that TwinCAT 3 can only read in one ESI file per drive controller series.

If you use different applications or PDO transmission configurations, you must expand your ESI with the corresponding
modules. Further information on modular ESI files can be found in the EtherCAT manual.

A new ESI file must be generated and made available to TwinCAT 3 each time the PDO transmission or project configuration
template is changed.

ü You are in DriveControlSuite and have completed the configuration of the PDO transmission.

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >
Wizard area.

2. Select the EtherCAT wizard.

3. Click on Create ESI.

ð The Write ESI file dialog box opens.

4. Save the XML file in the directory where the controller will read it from (TwinCAT 3 default installation: 
C:\TwinCAT\3.1\Config\IO\EtherCAT).

ð The ESI file is imported the next time TwinCAT 3 is started.
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8.4 TwinCAT 3: Configuring the safety technology
TwinCAT 3 offers the option of mapping your hardware environment using TwinCAT XAE. 
Parameterize all necessary bus parameters in the software automatically via hardware scan. Next, configure a customized
safety program that manages the STO and SS1 safety request signals. 
Predefined function blocks that connect you to the desired inputs and outputs are available for this purpose. The
configuration of a safety program is described below using the example of the safeEstop (Emergency Stop) function block.
Lastly, you will transmit the finished safety program to the FSoE MainInstance.

Be aware that it must be possible to obtain unique identification of all FSoE system devices in the EtherCAT network by
means of a customized FSoE address (setting via DIP switches). Enter the FSoE addresses before installing and networking
the individual devices and terminals.

Information

Always perform the steps described below in the specified order!

Some parameters are interdependent and do not become accessible to you until you have first configured certain settings.
Follow the steps in the specified sequence so that you can finish the parameterization completely.

8.4.1 Activating the EtherCAT MainDevice

ü You have already projected all drive controllers of your system using DriveControlSuite and transmitted the
configuration to the individual drive controllers. The EtherCAT MainDevice is connected to the network, all safety
components have an FSoE address and are energized, and the infrastructure is ready for operation. You have saved
the generated ESI file in the specified directory. The ESI files for Beckhoff devices are already stored in the TwinCAT
system.

1. Start TwinCAT XAE.

ð The stored ESI file is read in upon program start and the main window opens. Start page tab is active.

2. Select File > New > Project....

ð The New Project window opens.

3. Select Installed > Templates > TwinCAT Projects > TwinCAT XAE Project (XML format).

4. Name, Location, Solution name: 
Label the project and enter a save location and an internal project name.

5. Close the window.

6. Continue based on the type of installation:

6.1. If the run-time package (EtherCAT MainDevice) and TwinCAT XAE have been installed on the same PC, they are
connected to each other automatically.
Continue to step 16.

6.2. If the run-time package (EtherCAT MainDevice) and TwinCAT System Manager have been installed on different
PCs, you must connect them to each other.
If routing to the controller has already been created, continue with step 15.
If a new device is to be connected, perform all of the following steps.

7. Click on the <Local> list field in the TwinCAT XAE toolbar and select Choose Target System....

ð The Choose Target System window opens.

8. Click on Search (Ethernet)....

ð The Add Route Dialog window opens.

9. Click on Broadcast Search.

ð The Select Adapter(s) window opens.
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10. Highlight the adapter that is connected with your controller and confirm with OK.

ð All available control systems are listed.

11. Highlight the desired controller and confirm with Add Route.

ð The Add Remote Route window opens.

12. Under Remote User Credentials, enter the following data:
User name: Administrator
Password: 1

13. Confirm with OK.

14. Close the Add Route Dialog and Choose Target System windows.

15. Click on the <Local> list field in the TwinCAT XAE toolbar and select the added controller from the picklist.

ð The EtherCAT MainDevice is saved as the target system.

16. In order to be able to configure the EtherCAT system online, you must activate Config mode for the TwinCAT XAE
software.
Select the menu TWINCAT > Restart TwinCAT (Config mode).

ð The Restart TwinCAT System in Config Mode dialog box opens.

17. Confirm with OK.

ð The EtherCAT MainDevice is saved as the target system, TwinCAT XAE is in Config mode.

8.4.2 Scanning the hardware environment
If all system components are connected to the EtherCAT network and the network is energized, it is possible to scan for
connected devices automatically. In this scenario, TwinCAT XAE searches for connected devices and terminals and
integrates them into the existing project in accordance with their configuration entries in the accompanying ESI files.

If the actual EtherCAT infrastructure is not available, i.e. you are configuring in offline mode, you must map and project all
connected devices manually in TwinCAT XAE. You can get more detailed information on this in the online help tool of the
TwinCAT XAE software.

ü You have activated Config mode.

1. In the solution explorer, navigate to I/O > Devices > Scan context menu.

2. Confirm the HINT: Not all types of devices can be found automatically dialog box with OK.

ð TwinCAT XAE scans the EtherCAT system for the EtherCAT MainDevice.

ð The ... new I/O devices found dialog box opens.

3. Activate the relevant EtherCAT MainDevice and confirm with OK.

ð The EtherCAT MainDevice is created in the solution explorer under I/O > Devices as a device (EtherCAT).

ð The Scan for boxes? dialog box opens.

4. Confirm with Yes.

ð TwinCAT XAE scans the EtherCAT system for the EtherCAT SubDevices.

ð The EtherCAT drive(s) added dialog box opens.

5.  Append linked axis to:
If a NC or CNC function is required, activate the desired option and confirm with OK.

ð The EtherCAT SubDevices bus coupler (EK1100 terminal) along with the FSoE MainInstance (EL6900 terminal),
secure inputs (EL1904 terminals) and the drive controller are created in the solution explorer. 
The Activate Free Run dialog box opens.

6. In order to shift the system components during configuration into Free run mode and thereby enable verification of
the signal exchange, confirm with Yes.

ð EtherCAT MainDevice and SubDevices are created in TwinCAT XAE.
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8.4.3 Configuring the TwinCAT SAFETY project
A TwinCAT SAFETY project consists of a TwinSAFE group with alias devices, i.e. the hardware components of your system
and the actual SAFETY element along with accompanying function blocks that represent safety-related logic. The function
blocks contain parameters that must be adapted according to the application.

The first step is to create a SAFETY project along with alias devices and then configure the function block safeEstop, for
example.

8.4.3.1 Creating the TwinCAT SAFETY project

1. In the solution explorer, navigate to SAFETY > Context menu Add New Item.

ð The Add New Item dialog box opens.

2. Highlight the entry TwinCAT Safety Project Preconfigured ErrAc.

3. Name: 
Label the SAFETY project and confirm with Add.

ð The TwinCAT Safety Project Wizard dialog box opens.

4. Internal Project Name: 
If necessary, enter an internal project name and confirm with OK.

ð The SAFETY project with the name you provided, a target system and a TwinSAFE group are created in the solution
explorer. The TwinSAFE group already includes a folder for the alias devices to be created; the alias device
ErrorAcknowledgement.sds is available as a reset input by default.

5. In order to define the FSoE MainInstance as the target system, select the newly created SAFETY project in the solution
explorer and double click on Target System.

6. Main window > Physical Device: 
Click on the appropriate icon.

ð The Choose physical terminal for mapping dialog box opens.

7. Terminal: 
Select FSoE MainInstance EL6900 and confirm with OK.

8. Main window > Hardware Address: 
The FSoE address of the FSoE MainInstances has been read into TwinCAT XAE automatically.

9. In order to save the project, select FILE > Safe Selected Items.

ð The SAFETY project is created and the FSoE MainInstance is configured as the associated target system.
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8.4.3.2 Creating alias devices

The hardware required for the SAFETY project is incorporated into the TwinSAFE group as the respective alias device.

1. In the solution explorer, navigate to your SAFETY project > TwinSafeGroup1 > Alias Devices > Context menu Add >
New Item.

ð The Add New Item dialog box opens.

2. To create an alias device as an input for starting the TwinSAFE group, select  Installed > Standard  > 1 Digital Input
(Standard).

3. Name: 
Label the alias device with RUN and confirm with Add.

4. In the solution explorer, reselect the Alias devices folder > Add context menu > New item.

5. To create an alias device for the safe inputs (EL1904 terminal), select  Safety  > EtherCAT > Beckhoff Automation
GmbH > 4 Digital Inputs.

6. Name: 
If necessary, label the device and confirm with Add.

7. In the solution explorer, reselect the Alias devices folder > Add context menu > New item.

8. To create an alias device for the drive controller with the integrated SY6 safety module, select  Safety  > EtherCAT >
STOEBER ANTRIEBSTECHNIK GmbH & Co. KG > 0xB1EC5956 - Safety (FSoE).

9. Name: 
If necessary, label the device and confirm with Add.

ð The named hardware components are created as alias devices for the TwinSAFE group in the solution explorer.
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8.4.3.3 Assigning alias devices and entering FSoE addresses

Assign the created alias devices to the individual hardware components of your system and enter the accompanying 
FSoE addresses.

1. In the solution explorer, navigate to your SAFETY project > TwinSafeGroup1 > Alias Devices and double click on
ErrorAcknowledgement.sds.

2. Main window > Full name: 
Click on the appropriate icon.

ð The Attach Variable Standard in Var 1 (output) dialog box opens.

3. Show Variables:
In order to display all devices, activate the option Used and unused.

4. Show Variables: 
In order to display the standard inputs, uncheck the checkbox Exclude other devices.

5. Select the desired standard input for the reset of the TwinSAFE group and confirm with OK.

6. In the solution explorer, select the folder Alias Devices and double click on RUN.sds.

7. Main window > Full name: 
Click on the appropriate icon.

ð The Attach Variable Standard in Var 1 (output) dialog box opens.

8. Select the desired standard input for starting the TwinSAFE group and confirm with OK.

ð The hardware standard inputs for resetting and starting the TwinSAFE group are linked with the accompanying
alias devices.

9. In the solution explorer, select the folder Alias Devices and double click on 4 digital inputs_1.sds.

10. Main window > Linking tab > Physical Device: 
Click on the accompanying icon.

ð The Choose physical channel dialog box opens.

11. Select the first module of the EL1904 terminal and confirm with OK.

ð Terminal EL1904 is linked with the corresponding alias device.

12. Linking tab > FSoE address: 
The FSoE address of the EL1904 terminal has been read into the TwinCAT XAE Dip Switch field during the hardware
scan automatically. In order to apply the address, click on the accompanying icon.

ð The address is taken from the Dip switch field and input into the FSoE address field.

13. In the solution explorer, select the Alias Devices folder and double click on 0xB1EC5956 – Safety(FSoE).sds.

14. Main window > Linking tab > Physical Device: 
Click on the accompanying icon.

ð The Choose physical channel dialog box opens.

15. Select the first module of the drive controller with the integrated SY6 safety module and confirm with OK.

ð The drive controller is linked with the corresponding alias device.

16. Linking tab > FSoE address: 
The FSoE address of the safety module has been read into the TwinCAT XAE Dip switch field during the hardware scan
automatically. In order to apply the address, click on the accompanying icon.

ð The address is taken from the Dip switch field and input into the FSoE address field.

17. Connection tab > Watchdog (ms): 
Enter the watchdog time.
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18. In order to specify the SS1 delay time after which the STO function is triggered automatically, select the Safety
Parameters tab > parameter T_SS1 in the main window.

19. T_SS1:
Double click on the entry.

ð The Set Value dialog box opens.

20. Dec.:
Enter the SS1 delay time as a multiple of 10 ms and confirm with OK.

ð The hardware components are linked with the corresponding alias devices and the FSoE addresses are entered.

Information

Enter the SS1 delay time as a multiple of 10 ms. A T_SS1 of 100 corresponds to 1 s (100 × 10 ms = 1 s).

Assign a larger value for T_SS1 than for the quick stop time of the drive controller. The reserve should generally be 10% and
should not fall below 50 ms.

Information

Assign a sufficiently large value for the watchdog time.

Note the following condition:
S27 Safety watchdog time > A258 EtherCAT PDO-Timeout + S26 FSoE cycle time + 26 ms.



8 | Commissioning STOBER

40

08
/2

02
4 

| 
ID

 4
42

74
4.

04

8.4.3.4 Configuring the function block

Using the safeEstop function block, configure an emergency stop button that is connected to the secure input terminal
EL1904 via two NC contacts.

8.4.3.4.1 Creating a function block and assigning signal sources

2

54

1
3

Fig. 5: TwinCAT 3 – Configuring safeEstop function block and assigning signal sources

1. In the solution explorer, navigate to your SAFETY project > TwinSafeGroup1 and double click on 
TwinSafeGroup1.sal (1).

2. VIEW menu (2): 
Open the Toolbox view.

3. Toolbox > Function blocks (boolean) (3): 
Drag and drop the safeEstop function block into the main window > TwinSafeGroup1.sal tab.

4. Click to the left of the icon for Restart.

5. Label the variable with RestartInput.

6. Click to the left of the icons for both EStopIn1 and EStopIn2.

7. Label the variables with Channel1 and Channel2.

8. Click to the right of the icons for both EStopOut and EStopDelOut.

9. Label the variables with Stop and StopVerz.

10. Delay time (ms): 
Enter the SS1 delay time configured in T_SS1 . 
Be aware that the value in this entry field is NOT multiplied by a factor of 10 within the system.

ð All necessary variables for configuring the safeEstop function block have been created.
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11. In the message view, switch to the Variable Mapping tab > Variables subtab (4).

ð The previously defined variables for the function block are listed in the Assigned Variable column.

12. RestartInput variable > Alias Port column: 
Click on the accompanying button.

ð The Map to dialog box opens.

13. Usage: 
Activate the Used and unused option.

14. Assign the ErrorAcknowledgement alias device to the variable and confirm with OK.

15. Variables subtab > Variables Channel1 and Channel2 > Alias port column: 
Click on the accompanying buttons.

ð The Map to dialog box opens.

16. Assign the alias device 4 digital inputs > Channel1 > InputChannel1 to the variable Channel1 and 4 digital inputs >
Channel2 > InputChannel2 to the variable Channel2 and confirm with OK.

17. Variables subtab > Variables Stop and StopVerz > Alias Port column: 
Click on the accompanying buttons.

ð The Map to dialog box opens.

18. Assign the alias device 0xB1EC5956 - Safety (FSoE)  > Channel > SS1 to the variable Stop and the alias device
0xB1EC5956 - Safety (FSoE)  > Channel > STO to variable StopVerz, confirm with OK.

ð All configured variables for the safeEstop function block have been linked to the associated alias devices.

19. Switch to the Group Ports subtab (5).

20. Variables ErrAck and Run/Stop > Alias Port column: 
Click on the accompanying buttons.

ð The Map to dialog box opens.

21. Usage: 
Activate the Used and unused option.

22. Assign the alias devices ErrorAcknowledgement and RUN of the TwinSAFE group to the variables, respectively, and
confirm with OK

ð The configured function block is available for download to the FSoE MainInstance.
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8.4.3.4.2 Transmitting the function block

Validate the configured function block and transmit it to the FSoE MainInstance.

1. In the solution explorer, navigate to your SAFETY project > TwinSafeGroup1 and double click on TwinSafeGroup1.sal.

2. Select the menu TWINSAFE > Verify Complete Safety Project.

3. If validation was successful, the status VERIFICATION PROCESS SUCCEEDED is displayed in the left area of the footer of the
TwinCAT XAE interface.

4. Select the menu TWINSAFE > Download Safety Project.

ð The Check if the addresses configured on hardware terminals [...] dialog box opens.

5. Confirm the prompt with Yes.

ð The Download Project Data > Steps: Login dialog box opens. 
The download to the FSoE MainInstance is password-protected.

6. Login area:
Enter the following information for a new device (TwinCAT standard access) and confirm with Next: 
Username: Administrator
Serial Number: Serial number of the FSoE MainInstance
Password: TwinSAFE

ð The Download Project Data > Steps: Download dialog box opens.

7. Begin the download by clicking on Next.

ð The Download Project Data > Steps: Final Verification dialog box opens.

8. Final Verification area > I have manually verified the data shown [...] confirmation prompt:
Check the configured data, confirm the confirmation prompt by checking the accompanying checkbox and click on
Next.

ð The Download Project Data > Steps: Activation dialog box opens.

9. Activation area > Password: 
Enter the TwinSAFE password again and confirm with Finish.

ð The function block is transmitted to the FSoE MainInstance.

10. Restart the TwinCAT system: 
Select the menu Actions > Set/Reset TwinCAT to Config Mode.

ð The Restart TwinCAT System in Config Mode dialog box opens.

11. Confirm with OK.

8.4.4 Checking the function of the TwinSAFE group
Check that the TwinSAFE group functions correctly.

1. In the solution explorer, navigate to your SAFETY project > TwinSafeGroup1 and double click on TwinSafeGroup1.sal.

2. Select the menu TWINSAFE > Show Online Data.

ð The FSoE MainInstance (terminal EL6900) is stopped, the safeEstop function block is deactivated, the
accompanying status is set to red.

3. Start the TwinSAFE group via RUN = true.

4. Unlock the emergency stop button and press the reset button.

ð The function block is not active and the TwinSAFE group works correctly.



STOBER 8 | Commissioning
08

/2
02

4 
| 

ID
 4

42
74

4.
04

43

8.5 Checking safety functions
The SY6 safety module is a safety component in the sense of the Machinery Directive in accordance with Annex V. It
guarantees functional safety, e.g. protection against errors in the hardware and firmware. However, it does not guarantee
the safety of the entire process or the safety of the configuration.

The machine manufacturer must check and verify the functional capability of the safety functions used. The safety functions
may only be checked by qualified personnel. The result of the check must be documented in a test report.

The check of the safety function must be performed:

§ After initial commissioning

§ After changing the configuration of the safety functions

§ After exchanging the safety module or drive controller

A complete check includes:

§ The proper execution of the safety functions used in the SY6 safety module

§ The proper execution of the overall safety function (e.g. combination and integration of safety functions)

§ A parameter check

The check is based on:

§ The requirements for the safety functions of the SY6 safety module from the risk analysis of the machine or process

§ The description of the SY6 safety module and its safety functions in accordance with this manual

§ All safety-related parameters and values of the safety functions used

The test report must contain the following:

§ A description of the application, including an image

§ A description of the safety-related components (including software versions) that are used in the application

§ A list of the safety functions used

§ The results of all checks of these safety functions

§ A list of all safety-related parameters and their values

§ Checksums, test date and confirmation by the testing personnel

Safety tests in structurally identical applications may be performed as an individual type test of the identical application,
provided that it can be ensured that the safety functions are configured in all devices as intended.

Information

The test must be repeated and it must be noted in the test report if parameters were changed that have an influence on
the safety functions.
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9 Diagnostics
In the event of fault, the various diagnostic options described below are available.

9.1 LED display
The drive controllers feature diagnostic LEDs that visualize the state of fieldbus communication and the states of the
physical connection.

9.1.1 EtherCAT state
The 2 LEDs on the front of the drive controller provide information about the connection between the EtherCAT 
MainDevice and SubDevice and the state of the data exchange. This information can also be read out in parameter A255. If 
the drive controller includes the SY6 safety module, the safety functions are controlled using EtherCAT FSoE. In this case, 
an additional LED on the front of the device provides information about the FSoE state.

1
2

Err
Run
FSoE

Fig. 6: LEDs for the EtherCAT state

1 Red: Error

2 Green: Run

Red LED Conduct Error Description

Off No Error No error

Flashing Invalid Configuration Invalid configuration

Single flash Unsolicited State Change The EtherCAT SubDevice changed operating
states by itself

Double flash Application Watchdog
Timeout

The EtherCAT SubDevice did not receive new
PDO data during the configured watchdog
timeout

On Application controller
failure

Internal device communication error; switch
device off and on again

Tab. 6: Meaning of the red LED (error)
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Green LED Conduct Operating state Description

Off Init No communication between the EtherCAT
MainDevice and SubDevice; the
configuration starts, saved values are loaded

Flashing Pre-operational No PDO communication; the EtherCAT
MainDevice and SubDevice exchange
application-specific parameters via SDOs

Single flash Safe-operational The EtherCAT SubDevice sends the current
actual values to the EtherCAT MainDevice,
ignores its set values and refers to internal
default values

On Operational Normal operation: The EtherCAT MainDevice
and SubDevice exchange set and actual
values

Tab. 7: Meaning of the green LED (Run)



9 | Diagnostics STOBER

46

08
/2

02
4 

| 
ID

 4
42

74
4.

04

9.1.2 FSoE state (option SY6)
If the drive controller includes the SY6 safety module, the STO and SS1 safety functions are controlled using EtherCAT FSoE.
In this case, an LED on the front of the device provides information about the state of FSoE communication. This
information can also be read out in parameter S20 FSoE status indicator.

Err
Run
FSoE1

Fig. 7: LED for the FSoE state

1 Green: FSoE

Green LED Conduct Description

Off Initialization

Flashing Ready for parameterization

On Normal operation

Single flash Failsafe command from FSoE MainInstance received

Rapid flashing Undefined connection error

Rapid flashing with 1x flash Error in the safety-related communication settings

Rapid flashing with 2x flash Error in the safety-related application settings

Rapid flashing with 3x flash Incorrect FSoE address

Rapid flashing with 4x flash Prohibited command received

Rapid flashing with 5x flash Watchdog error

Rapid flashing with 6x flash CRC error

Tab. 8: Meaning of the green LED (FSoE status indicator in accordance with IEC 61784-3)
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9.1.3 EtherCAT network connection
The LEDs LA ECIN and LA ECOUT at X200 and X201 on the top of the device indicate the state of the EtherCAT network
connection.

LA
LA

IN
EC

X2
00

:
O

U
T

EC
X2

01
:

1

2

3

4

Fig. 8: LEDs for the state of the EtherCAT network connection

1 Green: LA ECOUT at X201

2 Yellow: No function

3 Green: LA ECIN at X200

4 Yellow: No function

Green LED Behavior Description

Off No network connection

Flashing Active data exchange with other EtherCAT nodes

On Network connection exists

Tab. 9: Meaning of the green LEDs (LA)
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9.2 Parameters
The following diagnostic parameters are available in the safety technology with drive controllers of the SC6 or SI6 series and
SY6 safety module.

9.2.1 E54 | Information safety module | SI6 | V1
Signifying data of the safety module.

§ [0]: Type

§ [1]: Hardware version

§ [2]: Production number

§ [3]: Firmware version

§ [4] – [5]: Reserved

§ [6]: Diagnostic code

9.2.2 E67 | STO state | SI6 | V3
STO state of the safety module:

§ [0]: STO is requested
Source: logical OR link between E67[1] and E67[2] including a deactivation delay

• 0: Inactive = not requested

• 1: Active = requested

§ [1]: STO requested by safety channel 1
SR6 source: terminal X12.1/X12.2, signal STOa = 0

• 0: Inactive = not requested

• 1: Active = requested

§ [2]: STO requested by safety channel 2
SR6 source: terminal X12.3/X12.4, signal STOb = 0

• 0: Inactive = not requested

• 1: Active = requested

The deactivation delay is 32 ms for the SR6, SY6 or SU6 safety modules.

With the SR6, SY6 or SU6 safety modules, the STO acts globally, i.e. on both axes of a double-axis controller simultaneously.
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9.2.3 S20 | FSoE status indicator | SI6 | V2
State of the transmission of safety-related data via FSoE.

Corresponds to the FSoE status indicator in accordance with IEC 61784-3.

Normal

§ 0 hex = Initialization
Possible in the FSoE state Pre-Reset

§ 1 hex = Ready for parameterization by the FSoE MainInstance
Possible in the FSoE states Reset, Session, Connection, Parameter

§ 2 hex = Normal operation
Possible in the FSoE state Process Data

§ 3 hex = Failsafe command received by the FSoE MainInstance
Possible in the FSoE state Failsafe Data

Error

§ 4 hex = Undefined connection error
Possible in all FSoE states

§ 5 hex = Error in the safety-related communication settings
Possible in the FSoE state Parameter

§ 6 hex = Error in the safety-related application settings 
Possible in the FSoE state Parameter

§ 7 hex = Incorrect FSoE address 
Possible in the FSoE state Connection

§ 8 hex = Prohibited command received via FSoE communication interface
Possible in all FSoE states

§ 9 hex = Data transmission timeout (watchdog)
Possible in all FSoE states

§ A hex = Inconsistent data transmission (CRC checksum)
Possible in all FSoE states

9.2.4 S21 | FSoE slave address | SI6 | V1
Drive controller address (FSoE SubInstance) in the EtherCAT network (prerequisite: FSoE MainInstance is active; source: 
DIP switch).

Address changes are applied when the drive controller is restarted.
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9.2.5 S25 | Safety module diagnostic code | SI6 | V2
Status byte with diagnostic code of the safety module.

§ Bit 0: Internal OSSD channel error

§ Bit 1: Reserved

§ Bit 2: FSoE communication error

§ Bit 3: Reserved

§ Bit 4: Overtemperature

§ Bit 5: Reserved

§ Bit 6: SS1 time 
0 = not running; 1 = running

§ Bit 7: STO state
1 = in safe state

If not otherwise specified: 0 = inactive; 1 = active.

9.2.6 S26 | FSoE cycle time | SI6 | V1
Measured FSoE cycle time.

S26 is the sum of the processing time in the FSoE SubInstance, the processing time in the FSoE MainInstance and the
duration for PDO transmission in the EtherCAT network.

9.2.7 S27 | Safety watchdog time | SI6 | V2
Tolerated failure time of FSoE frames for monitoring FSoE communication in the EtherCAT network (use: triggering internal
STO; source: FSoE MainInstance).

FSoE monitoring is fundamentally independent of PDO monitoring and is specified by the FSoE MainInstance (PDO
monitoring: A258).

However, please note the following condition in practical operation:

S27 Safety watchdog time > A258 EtherCAT PDO-Timeout + S26 FSoE cycle time + 26 ms

9.2.8 S544 | Safety controlword | SI6 | V2
Control byte for FSoE.

Corresponds to the Safety controlword communication object in accordance with ETG.6100.3; object 6620 hex.

SY6

§ [0]: First byte
Corresponds to the 1st byte communication object in accordance with ETG.6100.3; subindex 1 hex

• Bit 0: STO
0 = Activate STO; 1 = Do not activate STO

• Bit 1: SS1
0 = Activate SS1; 1 = Do not activate SS1

• Bits 2 – 7: Reserved

§ [1] – [5]: Second to sixth byte: Reserved
Corresponds to the 2nd byte to 6th byte communication objects in accordance with ETG.6100.3; subindex 2 hex to
6 hex

To enable the power unit, bit 0 and bit 1 must be set to 1.
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9.2.9 S545 | Safety statusword | SI6 | V2
Status byte for FSoE.

Corresponds to the Safety statusword communication object in accordance with ETG.6100.3; object 6621 hex.

SY6

§ [0]: First byte
Corresponds to the 1st byte communication object in accordance with ETG.6100.3; subindex 1 hex

• Bit 0: STO
1 = STO active

• Bits 1 – 7: Reserved

§ [1] – [5]: Second to sixth byte: Reserved
Corresponds to the 2nd byte to 6th byte communication objects in accordance with ETG.6100.3; subindex 2 hex to
6 hex

9.2.10 S593 | SS1 time until STO | SI6 | V0
SS1 delay time, i.e. the duration between the activation of a time-based SS1 by S544 Safety controlword, bit 1, and the
internal triggering of the STO function (unit: 10 ms; source: FSOE MainInstance).

Corresponds to the SS1 time until STO communication object in accordance with ETG.6100.3; object 6651 hex.

A change to the SS1 delay time in the FSoE MainInstance takes effect and becomes visible in parameter S593 the next time
the FSoE MainInstance is restarted.
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9.3 Events
The drive controller has a self-monitoring system that uses test rules to protect the drive system from damage. Violating
the test rules triggers a corresponding event. There is no possible way for you as the user to intervene in some events, such
as the Short/ground event. In others, you can influence the effects and responses.

Possible effects include:

§ Message: Information that can be evaluated by the controller

§ Warning: Information that can be evaluated by the controller and becomes a fault after a defined time span has
elapsed without the cause being resolved

§ Fault: Immediate drive controller response; the power unit is disabled and axis movement is no longer controlled by
the drive controller or the axis is brought to a standstill by a quick stop or emergency braking

Depending on the event, there are various measures you can take to rectify the cause. As soon as the cause has been
successfully rectified, you can usually acknowledge the event immediately. If the drive controller has to be restarted, a
corresponding note can be found in the measures.

ATTENTION!

Damage to property due to interruption of a quick stop or emergency braking!

If, when executing a quick stop or emergency braking, a fault occurs or STO is active, the quick stop or emergency braking is
interrupted. In this case, the machine can be damaged by the uncontrolled axis movement.

Information

To make it easier for control programmers to set up the human-machine interface (HMI), a list of events and their causes
can be found in the STOBER download center at http://www.stoeber.de/en/downloads/ by searching for Events.

9.3.1 Event 50: Safety module
The drive controller has a fault:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The behavior of the brakes depends on the configuration of the safety module

Information

A rising edge for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Cause Check and action

2: Wrong safety module The projected E53 safety module
does not match the E54[0]
detected by the system

Check the project configuration and drive
controller and correct the project configuration
or exchange the drive controller if necessary;
fault cannot be acknowledged

3: Internal error Defective safety module Exchange drive controller; fault cannot be
acknowledged

Tab. 10: Event 50 – Causes and actions

http://www.stoeber.de/en/downloads/
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9.3.2 Event 70: Parameter consistency
The drive controller has a fault:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The behavior of the brakes depends on the configuration of the safety module

Information

A rising edge for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Information

The event is only triggered if the checking rules for Enable-on are violated.

Cause Check and action

SY6 option:
15: Safety watchdog time

Monitoring of PDO timeout
deactivated

Check the EtherCAT PDO timeout in the drive
controller and activate it if necessary (A258 = 0
or 65535)

SyncManager watchdog = 0 Check the EtherCAT SyncManager watchdog in
the EtherCAT MainDevice and increase it if
necessary (A258 = 65534, A259[0])

Ratio of FSoE watchdog time to
EtherCAT PDO timeout too small

Check the FSoE watchdog time in the FSoE
MainInstance and EtherCAT PDO timeout in the
drive controller; if necessary, increase the
watchdog time or reduce the timeout
(condition: FSoE watchdog time > EtherCAT
PDO timeout + FSoE cycle time + 26 ms; S27,
A258, S26)

Ratio of FSoE watchdog time to
EtherCAT SyncManager watchdog
too small

Check the FSoE watchdog time in the FSoE
MainInstance and EtherCAT SyncManager
watchdog in the EtherCAT MainDevice; if
necessary, increase the watchdog time or
reduce the SyncManager watchdog (condition:
FSoE watchdog time > EtherCAT SyncManager
watchdog + FSoE cycle time + 26 ms; S27, 
A258 = 65534, A259[0], S26)

Tab. 11: Event 70 – Causes and actions
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10 More information on FSoE, safety functions and
SY6?

This chapter summarizes the important terms, relationships and measures regarding FSoE, the STO and SS1 safety functions
and the SY6 safety module.

10.1 FSoE: Fail Safe over EtherCAT
The safety protocol known as Safety over EtherCAT (FSoE = Fail Safe over EtherCAT) exists within the real-time Ethernet
system EtherCAT for transmitting safety-related messages between FSoE devices in a network. The protocol is
internationally standardized in accordance with the IEC 61784-3 standard. The design of FSoE is based on the black channel
principle.

Secure communication

During each FSoE cycle, an FSoE MainInstance sends safety-related data to an FSoE SubInstance and simultaneously starts a
watchdog timer. The FSoE SubInstance acknowledges the received data before sending it back to the MainInstance and also
begins runtime monitoring via a watchdog timer. The MainInstance receives and processes the acknowledgement of the
SubInstances and stops the watchdog timer. If the data has been fully processed, the FSoE MainInstance generates a new
data packet.

Unique addressing

It must be possible to identify each FSoE SubInstance using a unique FSoE address.

The address is assigned to the drive controller using DIP switches. A valid address is within the address range 1 – 255 (8 bit,
0 address may not be assigned).

10.2 Safety functions
The SY6 safety module supports the Safe Torque Off (STO) and Safe Stop 1 (SS1-t) safety functions. In order to move the
axis, the safety controller must set both the STO and SS1 control bit of the drive controller. If only one of the two control
bits is set, the drive controller remains in a safe state (STO active).

The safety functions relate to the device and are not axis-specific. This means that for multi-axis controllers, only the entire
drive controller can be set to a safe state, not individual axes.
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10.2.1 Safe Torque Off – STO
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Fig. 9: STO function principle in accordance with ETG.6100.2

STO in accordance with EN 61800-5-2 corresponds to stop category 0 in accordance with EN 60204.

STO is the most fundamental drive-integrated safety function. STO prevents energy that generates torque from acting on
the connected motor and prevents unintentional start-up. The goal is to safely eliminate material damage and injuries to
persons caused by a rotating or unintentionally activated motor.

The use of STO is always suitable if the motor comes to a standstill on its own in a sufficiently short time period due to load
torque or friction or in an environment in which motor coasting does not have safety-related implications.
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10.2.2 Safe Stop 1 – SS1-t
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Fig. 10: SS1-t function principle in accordance with ETG.6100.2

t0 SS1 activation

t1 STO activation

T_SS1 SS1 delay time

SS1 in accordance with EN 61800-5-2 corresponds to stop category 1 in accordance with EN 60204-1.

In the case of SS1-t, the switch-off happens after a configurable amount of time.

The SS1-t safety function enables controlled stopping of a motor and switches it to a torque-free state after the
parameterized SS1 delay time has passed, i.e. the STO safety function is activated. STO is triggered after a time delay,
regardless of whether the motor has already reached a standstill.

WARNING!

Increased overrun distance! Residual motion!

The safety module cannot prevent a failure of the functional part of the drive controller (e.g. during a controlled stop) while
the SS1-t safety function is executed. Therefore, SS1-t cannot be used if this failure could cause a dangerous situation in the
end application. Observe this during project configuration.

In the event of an error in the power unit of the drive controller, static energization of the motor is possible despite active
STO. In this case, the motor shaft can move by an angle of up to 360° ÷ (p × 2).

Information

Be aware that the drive controller continues to follow the set values of the controller during the SS1 delay time, which
enables controlled stopping in multi-axis applications.
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The SS1 delay time T_SS1 is a safety-related parameter. The value of T_SS1 is transmitted from the safety controller to the
drive controller during the initialization of communication.

In DriveControlSuite, the value of T_SS1 is shown in parameter S593 SS1 time until STO.

10.3 SY6: Assigning the FSoE address
To be able to identify the SY6 safety module uniquely in the FSoE network, you must manually assign an FSoE address to it
from the address range 1 – 255 using the S12 DIP switches on the top of the drive controller. The address 0 is invalid, i.e.
when address 0 is assigned, the value is ignored and the SY6 safety module remains in the STO state.

Information

The drive controller must be switched off before you assign the address for the SY6 safety module using the S12 DIP
switches. The drive controller has to be restarted to apply the address.

Assigning the address using S12 DIP switches

The DIP switches for assigning the address are located on the top of the drive controller. The address is based on the values
from the DIP switches that are switched ON. The following graphic shows DIP switches S12.2 and S12.4 in the ON state.
Address 10 results from the associated values 2 and 8 of the DIP switches for the SY6 safety module.

8
1

2
3

4
5

6
7

O N

Fig. 11: SY6 – S12 DIP switches

S12 DIP switches 1 2 3 4 5 6 7 8

Value (address) 1 2 4 8 16 32 64 128

Tab. 12: S12 DIP switches and values

Checking the FSoE address

You can check the FSoE address you have entered for the SY6 safety module using parameter S21 FSoE slave address in
DriveControlSuite.
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10.4 Safety system time

Safety system time

Sensor Safe
input

FSoE
MainInstance

EtherCAT
MainDevice

EtherCAT
MainDevice

Communication Communication

Reaction time Reaction time Reaction time Reaction timeReaction timeReaction time

Drive controller

Fig. 12: Reaction times and safety system time

The safety system time is understood as the time span that passes from the request of a safety function to a sensor until
the safety function is triggered on the drive controller.

The safety system time depends on the reaction times as well as communication and transmission times of the individual
system components.

The reaction and communication times are produced from the following process:

§ Sensor:
Provides the request signal

§ Safe input:
Detects the request signal

§ EtherCAT MainDevice:
Transmits the status of the safe input to the FSoE MainInstance

§ FSoE MainInstance:
Evaluates the request signal

§ EtherCAT MainDevice:
Transmits the request signal to the drive controller

§ Drive controller:
Activates the safety function and deactivates it, if necessary (STO switch-off time); this process is divided as follows:

• Processing in the control unit

• Transmission of the data packet to the SY6 safety module

• SY6: Evaluation of the data packet

• Switch-off time of the power unit

10.5 Watchdog time
In order to detect possible faults, the communication between FSoE MainInstance and SubInstance is monitored by an FSoE
watchdog. As soon as an FSoE frame has been sent, both the MainInstance and SubInstance start the watchdog time. If the
MainInstance or SubInstance do not receive a corresponding response frame before the watchdog time expires, the
respective device switches to a safe state. The watchdog time is taken into account when calculating the worst case
response time.

The watchdog time is parameterized individually for each SubInstance in the FSoE MainInstance.

In TwinCAT 3, a global watchdog time of 100 ms is set by default. If you would like to change this default time, switch to the
properties of the respective alias devices of a TwinSAFE group for TwinCAT 3.
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11 Appendix

11.1 Supported communication objects

11.1.1 ETG.6100.3 Safety over EtherCAT Drive Profile: 6600 hex – 67FF hex
The following table includes the supported communication objects of the standardized ETG.6100.3 Safety over EtherCAT
Drive Profile and their mapping to the corresponding STOBER-specific parameters.

Index Subindex TxPDO RxPDO Name Comment

6600 hex 0 hex — — Time unit Unit: 10 ms

6620 hex Safety controlword Array with 2 elements

6620 hex 0 hex — — Highest subindex supported Constant value of 2 hex

6620 hex 1 hex — — Safety controlword, 
1st byte

S544[0]

6620 hex 2 hex – 6 hex — — Safety controlword, 
2nd - 6th byte

S544[1] – S544[5]; 
no function

6621 hex Safety statusword Array with 2 elements

6621 hex 0 hex — — Highest subindex supported Constant value of 2 hex

6621 hex 1 hex — — Safety statusword, 
1st byte

S545[0]

6621 hex 2 hex – 6 hex — — Safety statusword, 
2nd - 6th byte

S545[1] – S545[5]; no function

6640 hex 0 hex — — STO command supported Function is supported = 1

6641 hex 0 hex — — STO restart acknowledge STO restart without
acknowledge = 0

6650 hex 0 hex — — SS1 command supported Function is supported = 1

6651 hex 0 hex — — SS1 time to STO S593, unit defined in object
6600 hex

Tab. 13: ETG.6100.3 communication objects: 6600 hex – 67FF hex
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11.1.2 ETG.5001.4 Safety over EtherCAT: E000 hex – EFFF hex
The following table includes the supported communication objects of the standardized ETG.5001.4 Safety over EtherCAT
profile.

Index Subindex TxPDO RxPDO Name Comment

E901 hex FSoE connection
communication parameter

Record with 8 elements

E901 hex 0 hex — — Highest subindex supported Constant value of 8 hex

E901 hex 1 hex — — Version

E901 hex 2 hex — — FSoE SubInstance address

E901 hex 3 hex — — Connection ID

E901 hex 4 hex — ✓ Watchdog time

E901 hex 5 hex — — Reserved

E901 hex 6 hex — — Connection type

E901 hex 7 hex — — ComParameterLength

E901 hex 8 hex — — ApplParameterLength

F980 hex 0 hex — — FSoE SubInstance Address

Tab. 14: ETG.5001.4 communication objects: E000 hex – EFFF hex
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11.2 Detailed information
The documentation listed below provides you with further relevant information on the 6th STOBER drive controller
generation. The current status of the documentation can be found in our download center at:
http://www.stoeber.de/en/downloads/.
Enter the ID of the documentation in the search field.

Title Documentation Contents ID

SC6 drive controller Manual System design, technical data, project
configuration, storage, installation, connection,
commissioning, operation, service, diagnostics

442790

Multi-axis drive system with 
SI6 and PS6

Manual System design, technical data, project
configuration, storage, installation, connection,
commissioning, operation, service, diagnostics

442728

EtherCAT communication – 
SC6, SI6

Manual Electrical installation, data transfer,
commissioning, diagnostics, detailed
information

443025

CiA 402 application – 
SC6, SI6

Manual Project planning, configuration,
parameterization, function test, detailed
information

443080

Additional information and sources that form the basis of this documentation or are referenced by the documentation:

Beckhoff Automation GmbH & Co. KG (publisher): EtherCAT System Documentation. Version 5.1. Verl, 2016.

A free basic version of the TwinCAT 3 automation software is available at 
https://www.beckhoff.com/en-us/products/automation/twincat/te1xxx-twincat-3-engineering/te1000.html.

EtherCAT Technology Group (ETG), 2015. ETG.1300: EtherCAT Indicator and Labeling. ETG.1300 S (R) V1.1.0. Specification.
2015-07-03.

EtherCAT Technology Group (ETG), 2020. ETG.5001: Modular Device Profile, Part 4: Safety Modules Specification.
ETG.5001.4 S (D) V0.2.1. Specification. 2020-07-15.

EtherCAT Technology Group (ETG), 2020. ETG.6100: Safety Drive Profile, Part 1: Overview, Scope. ETG.6100.1 S (R) V1.2.0.
Specification. 2020-07-15.

EtherCAT Technology Group (ETG), 2020. ETG.6100: Safety Drive Profile, Part 2: Generic Safety Drive Profile for adjustable
speed electrical power drive systems that are suitable for use in safety-related applications PDS(SR). ETG.6100.2 S (R) V1.2.0.
Specification. 2020-07-15.

EtherCAT Technology Group (ETG), 2020. ETG.6100: Safety Drive Profile Part 3: Mapping to Safety-over-EtherCAT.
ETG.6100.3 S (WD) V1.2.0. Specification. 2020-07-15.

11.3 Formula symbols

Symbol Unit Explanation

p – Number of pole pairs

TM Year, a Mission time

http://www.stoeber.de/en/downloads/
https://www.beckhoff.com/en-us/products/automation/twincat/te1xxx-twincat-3-engineering/te1000.html
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11.4 Abbreviations

Abbreviation Meaning

µC Microcontroller

CRC Cyclic Redundancy Check

EMC Electromagnetic Compatibility

ESI EtherCAT SubDevice Information (device description of an EtherCAT SubDevice)

ETG EtherCAT Technology Group

EtherCAT Ethernet for Control Automation Technology

FSoE Fail Safe over EtherCAT

IGBT Insulated Gate Bipolar Transistor

I/O Input/Output

MInstance MainInstance

PDO Process Data Objects

PDS(SR) Power Drive System(Safety Related)

PDU Process Data Units

PL Performance Level

PWM Pulse Width Modulation

RxPDO Receive PDO (receive process data)

SIL Safety Integrity Level

SIL CL Safety Integrity Level Claim Limit

PLC Programmable Logic Controller

SRECS Safety-Related Electrical Control System

SRP/CS Safety-Related Part of a Control System

SS1 Safe Stop 1

SS1-t Safe Stop 1-time

STO Safe Torque Off

SubInstance SubordinateInstance

TwinCAT The Windows Control and Automation Technology

TxPDO Transmit PDO (transmit process data)



STOBER 12 | Contact
08

/2
02

4 
| 

ID
 4

42
74

4.
04

63

12 Contact

12.1 Consultation, service and address
We would be happy to help you!

We offer a wealth of information and services to go with our products on our website:
http://www.stoeber.de/en/service

For additional or personalized information, contact our consultation and support service:
http://www.stoeber.de/en/support

If you need our system support:
Phone +49 7231 582-3060
systemsupport@stoeber.de

If you need a replacement device:
Phone +49 7231 582-1128
replace@stoeber.de

Call our 24-hour service hotline:
Tel. +49 7231 582-3000

Our address:
STÖBER Antriebstechnik GmbH + Co. KG
Kieselbronner Strasse 12
75177 Pforzheim, Germany

12.2 Your opinion is important to us
We created this documentation to the best of our knowledge with the goal of helping you build and expand your expertise
productively and efficiently with our products.

Your suggestions, opinions, wishes and constructive criticism help us to ensure and further develop the quality of our
documentation.
If you want to contact us for a specific reason, we would be happy to receive an e-mail from you at:
documentation@stoeber.de

Thank you for your interest.
Your STOBER editorial team

http://www.stoeber.de/en/service
http://www.stoeber.de/en/support
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12.3 Close to customers around the world
We offer you committed, expert advise and support in over 40 countries worldwide:

STOBER AUSTRIA
www.stoeber.at
+43 7613 7600-0
sales@stoeber.at

STOBER CHINA 
www.stoeber.cn 
+86 512 5320 8850
sales@stoeber.cn

STOBER FRANCE 
www.stober.fr 
+33 478 98 91 80 
sales@stober.fr

STOBER Germany 
www.stoeber.de 
+49 4 7231 582-0
sales@stoeber.de

STOBER HUNGARY 
www.stoeber.de 
+36 53 5011140
info@emtc.hu

STOBER ITALY 
www.stober.it 
+39 02 93909570 
sales@stober.it

STOBER JAPAN 
www.stober.co.jp 
+81-3-5875-7583
sales@stober.co.jp

STOBER SWITZERLAND 
www.stoeber.ch 
+41 56 496 96 50 
sales@stoeber.ch

STOBER TAIWAN 
www.stober.tw 
+886 4 2358 6089 
sales@stober.tw

STOBER TURKEY 
www.stober.com 
+90 216 510 2290 
sales-turkey@stober.com

STOBER UK 
www.stober.co.uk 
+44 1543 458 858 
sales@stober.co.uk

STOBER USA 
www.stober.com 
+1 606 759 5090 
sales@stober.com
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Glossary

Black channel principle

Technology that allows secure data to be transmitted over unsecure network or bus lines. Safety components can
transmit safety-related data regardless of hardware using a secure protocol that tunnels through the underlying
network channel. Possible transmission errors are noted in the standards IEC 61784-3 and IEC 61508.

Broadcast domain

Logical grouping of network devices within a local network that reaches all nodes via broadcast.

Category

In accordance with DIN EN ISO 13849-1: Classification of safety-related parts of a controller regarding their resistance
to faults and their subsequent behavior in the event of a fault. A category is attained through the structure and the
arrangement of parts, their fault detection and/or their reliability. Possible category designations, i.e. classifications,
are B, 1, 2, 3, 4.

ESI file

Device description file for EtherCAT SubDevices. In accordance with ETG.2000: XML file that contains all relevant data
for an EtherCAT node in the EtherCAT system, such as the identity of the manufacturer, the product code, the version
or the production number. The EtherCAT MainDevice requires this file to configure the EtherCAT system.

EtherCAT MainDevice

Device that is responsible for network management and organizes the access of nodes to the shared medium. It is the
only node that actively sends frames.

EtherCAT SubDevice

Network node that processes and forwards frames. The last node sends the frame back to the device responsible for
network management.

Fail Safe over EtherCAT (FSoE)

Protocol for transferring safety-related data via EtherCAT using a FSoE MainInstance and an indefinite number of FSoE
SubInstances (i.e. devices that have a Safety over EtherCAT interface). The protocol enables the realization of
functional safety via EtherCAT. FSoE and its implementation are TÜV-certified and comply with the SIL 3 requirements
in accordance with IEC 61508.

FSoE address

Each FSoE SubInstance has an address that provides unique identification for it in the FSoE network. The address is 
generally configured on the device itself, for example using DIP switches. In an FSoE system, a maximum of 65,533 
nodes can be differentiated by their addresses. In the case of 16-bit addressing, the addresses 0 or 0000 hex and 
65,535 or FFFF hex are not permitted. In the case of 8-bit addressing, the address range 1 to 255 is available for the SY6 
safety module.



Glossary STOBER

66

08
/2

02
4 

| 
ID

 4
42

74
4.

04

FSoE MainInstance

Device of an FSoE connection that initiates the security communication. It sends an FSoE frame that contains the safe
outputs. An FSoE MainInstance can manage one or more FSoE SubInstances.

FSoE SubInstance

Network node of an FSoE connection that receives and processes the safe outputs and provides the safe inputs for the
MainInstance. An FSoE SubInstance is assigned to an FSoE MainInstance.

Insulated Gate Bipolar Transistor (IGBT)

Bipolar transistor with insulated gate electrode. Four-layer semiconductor component that is controlled using a gate
and combines the advantages of bipolar and field-effect transistor. An IGBT is primarily used in power electronics.

IPv4 limited broadcast

Type of broadcast in a network with IPv4 (Internet Protocol version 4). The IP address 255.255.255.255 is entered as
the destination. The content of the broadcast is not forwarded by a router, which limits it to the local network.

Mission time (TM)

In accordance with DIN EN 61800-5-2: Determined cumulative length of operation of the PDS(SR) during its overall
service life.

Performance Level (PL)

In accordance with DIN EN ISO 13849-1: Measure for the reliability of a safety function or a component. The
Performance Level is measured on a scale of a – e (lowest – highest PL). The higher the PL, the safer and more reliable
the function in question is. The PL can be assigned to a specific SIL. A reversed inference from a SIL to a PL is not
possible.

Probability of a dangerous failure per hour (PFHD)

In accordance with DIN EN 61508/DIN EN 62061: Average probability of a dangerous device failure per hour. Together
with PFH, one of the most important bases for calculating the safety function reliability of devices, the SIL.

Process Data Objects (PDO)

Communication objects in a CANopen or EtherCAT network that transmit data such as set and actual values, control
commands or status information based on events or objectives, in cycles or in real time on request. PDOs are generally
exchanged over the process data channel with high priority. Depending on the view of the respective node, a
distinction is made between receive PDOs (RxPDO) and transmit PDOs (TxPDO).

Quick stop time

Time that is an application-specific result of the quick stop deceleration and maximum velocity.
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Safe Stop 1 (SS1)

In accordance with DIN EN 61800-5-2: Procedure for stopping a PDS(SR). With the SS1 safety function, the PDS(SR)
performs one of the following functions: a) Triggering and controlling the motor delay variable within defined limits
and triggering the STO function if the motor speed falls below a specified limit value (SS1-d), or b) triggering and
monitoring the motor delay variable within defined limits and triggering the STO function if the motor speed falls
below a specified limit value (SS1-r), or c) triggering the motor delay and triggering the STO function after an
application-specific delay (SS1-t). In this case, SS1(-t) corresponds to the time-controlled stop in accordance with 
IEC 60204-1, stop category 1(-t).

Safe Torque Off (STO)

In accordance with DIN EN 61800-5-2: Procedure for stopping a PDS(SR). The STO safety function prevents the motor
from being supplied with any energy that could cause rotation (or motion in a linear motor). The PDS(SR) does not
supply the motor with any energy that could generate torque (or force in a linear motor). STO is the most fundamental
drive-integrated safety function. It corresponds to an uncontrolled stop in accordance with DIN EN 60204-1, stop
category 0.

Safety function

In accordance with DIN EN 61800-5-2: Function with a certain safety-related capability that is carried out in whole or in
part by a PDS(SR) and with which the safe state of a system is maintained or the development of hazardous states in
the system is prevented.

Safety Integrity Level (SIL)

In accordance with DIN EN 61800-5-2: Probability of a safety function failure. SIL is divided into levels 1 – 4 (lowest –
highest level). SIL precisely assesses systems or subsystems based on the reliability of their safety functions. The higher
the SIL, the safer and more reliable the function in question is.

Safety Integrity Level Claim Limit (SIL CL)

Maximum SIL that can be claimed, based on the structural limitations and systematized safety integrity of a SRECS
subsystem. A SIL CL is determined by the hardware fault tolerance (HFT) and the safe failure fraction (SFF) of the
subsystems.

Safety module

Accessory for drive controllers that enables the use of safety functions.

STO switch-off time

Time span starting from the activation of the safety function on the safety module until the drive controller power unit
is safely switched off.

Watchdog

Function that is used for cyclical monitoring of devices, connections or software. At STOBER, for example, the
watchdog is used to identify a communication failure between the controller and drive controller and activates in case
of a timeout where no data exchange has taken place between the devices before the watchdog time expired.
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Watchdog time

Time before the expiration of which a data exchange between two instances or devices must have taken place. If the
watchdog time is exceeded without a data exchange taking place, the watchdog is triggered.

Worst case response time

Maximum time span required in order to switch off the actuator in the event of an error.
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